ﬁ -fw;;.-- "y _ gy * ' Wi /e 4 A g
"L .,;;{ e ' ' ‘
% PN — WIN 95
. .y S WINSA

SHEEEE compatible

- | .*:‘.‘;:;E""‘-"““-.-‘.;- |
DAY 7% U e
é . _S [ E R R A-”

J 2 )
s A

\




CASINO DE LUXE

ENGLISH

— Jstalling Caltiio D& LAl . cmsioim i iiuim diemsidiseuosenvisswie 2
— CUSTOMET SEIVICE ..vvvvereriirriecersanneessessvsressosssresssssanessssssnsasasssssanssssssnsass 5
T BT Ty — 18
FRANCAIS

—Installation de CaRnn TIE Ll sunsnnmanninsissanmisiiiiisia 8
— SCIVICE CONSOMMIATEUL cvvvvvrrvrrsrssssesseaeseessesesssssssssssssssssnsseessssssssenssnnnn 11
L T e — 20
DEUTSCH

- Casing De Like Ing@Herehn . unnnaunimasnsasanaasaiaieias 13
s ICEIA CTMIICIREE. s asiasinmssnnsuniansunensooms bmivssvshsssanhnars s ur e s b ob s 16
L ryn L T (1 IR —— 22



CASINO
DE LUXE

a——
Y
— .'
g
=

Wt i

i
',a&

INSTALLATION AND INSTRUCTION CARD

Concept:

Design:

Programming:
Production:

Director of Technology:
Art Direction:
Graphics:

Sound:

Voice Talents:
Documentation and Research:
Testing:

David Lester

Dean Lawson, Glenn Oliver

Dean Lawson

Glenn Oliver

Dave Mitton

Chris Beatrice

Julie Airoldi, Chris Beatrice,

Heidi Mann, Scot Forbes,

Andrea Muzeroll, Chin-Mei Yu

Jay Rinaldi, Jeremy Bell

Michael Stanton, Lezli Whitehouse
‘Todd Capute, Jennifer Hawthorne
Philip Conrad, Ken Ford, Chris Foster,
Mike Lescault, Joe McGuire,
Edward Pugsley, Steven Serafino

Special Thanks to Eric Ouelletce
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INSTALLING CASINO DE LUXE

1) Make sure your computer is turned on and the Windows Program
Manager screen is displayed.

2) Place the CASINO DE LUXE game CD in your CD-ROM drive.

3) Under the File menu, select Run.

4) In the box that appears, type the letter of your CDD-ROM drive, followed
by a colon, then \SETUP.EXE and press the <Enter> key on your key-
board. For example, if your CD-ROM drive is your D drive, you would
type D:\SETUP.EXE and press <Enter>.

5) Follow the on-screen instructions. During the installation, you will be
given two options: you may either install the entire game to your hard
drive, or you may install only part of the game, the rest being accessed
from the CD as you play. If you install the entire game (“Hard Disk
Copy”), it will take up about 30 megabytes of space on your hard drive. If
you install part of the game (“CD resident”), the installed portion will take
up about 4 megabytes of space. Ifyou choose partial installation, make sure
the game CD is in your CD-ROM drive whenever you play the game or view
the strategy supplements. Full installation may result in faster gameplay.

6) The installation process will create a program group called Impressions,
which will contain the program icon for the game, as well as icons for the
strategy sections for each game in the package. To play CASINO DE
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LUXE, double click on the main game icon. To view the strategy hints

and tips sections, double click on the icon for the game whose section

you would like to view.
Once you enter the game, you will see an introductory sequence. Click your
mouse if you would like to skip through the screens. The computer will ask
you if you would like to begin a new game or load a saved game. If this is
your first time at CASINO DE LUXE, select New. If you would like to
continue a previously saved game, select Load, and choose your saved game
from the box that appears.
You will then find yourself in the lobby of CASINO DE LUXE. To begin,
click on the elevator doors (or select Go To Elevator from the menu bar),
and then select the button for the game you wish to play (or select Choose
Game from the menu bar). To exit CASINO DE LUXE from the lobby,
click on the glass doors (or select Exit Casino De Luxe from the File menu).
For general game instructions, select How to Play from the Help menu in
the lobby. Consult the Help menu in each game for specific instructions.
To save a game, sclect Save Game from the File menu, and type a name for
your game in the box that appears. Make sure your game has an extension of
“.sav” (example: mygame.sav).



SIERRA CUSTOMER SERVICE

SERVICES NUMBERS HOURS AVAILABLE
Customer/
Technical Support (01734) 303 171 9am.to5p.m.

Customer Service Fax
Bulletin Board Service

Hintline (Older Games)

New Hintline - UK only

(01734) 303 362
(01734) 304 227

(01734) 304 004

0891 660 660*

Monday - Friday

24 hrs.

24 hrs

Requires a modem.

24 hrs.

Requires a touch tone phone
Automated Service

24 hrs.

Available in the UK only.
Automated Service

* Costs 39p min. cheap rate, 49p at other times. Max. call length 7.5 mins, max. charge cheap rate
£2.93, max. charge at other times £3.68 (UK only).

* Charges correct at time of printing.

For further information, please write to:

SIERRA

Attention: Customer Service, 4 Brewery Court, Theale,
Reading, Berkshire RG7 5AJ - U.K.




* SIERRA ON COMPUSERVE
Sierra offers technical support and patch files on its CompuServe forum, as
well as product demos, hints, and reviews. CompuServe members can type

GO SIERRA to reach the forum.

IMPLIED WARRANTIES LIMITED: SIERRA MAKES NO WARRANTY, EXPRESS OR
IMPLIED, REGARDING THIS PRODUCT. Sierra disclaims any warranty that the softwa-
re is fit for a particular purpose, AND ANY IMPLIED WARRANTY OF MERCHANTABI-
LITY IS EXPRESSLY AND SPECIFICALLY DISCLAIMED, SOME STATES OR COUN-
TRIES DO NOT ALLOW LIMITATIONS ON WARRANTY, SO THE ABOVE
LIMATION MAY NOT APPLY TO YOU.

No consequential damages: Sierra shall not be liable for special, incidental, consequential or
other damages, even if Sierra is advised of or aware of the possibility of such damages. This
means that Sierra shall not be responsible or liable for lost profits or revenues, or for damages or
costs incurred as a result of loss of time, data or use of the software, or from any other cause
except the actual cost of the product. In no event shall Sierra's liability exceed the purchase
price of this product. SOME STATES OR COUNTRIES DO NOT ALLOW THE EXCLU-
SION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO
THE ABOVE LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

You are entitled to use this product for your own use, but may not sell or transfer reproductions
of the software manual or book to other parties in any way, nor rent or lease the producr ro
others. You may use one copy of the product on a single terminal connected to a single com-
puter. You may not network the product or otherwise install it on more than one computer or
computer terminal at the same time
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CARTE D’INSTALLATION ET DINSTRUCTIONS

Concept :

Création :
Programmation :
Production:
Directeur technique :
Direction artistique :
Graphisme :

Son:

Voix :

Documentation et recherche :
Tests :

David Lester

Dean Lawson, Glenn Oliver

1Jean Lawson

Glenn Oliver

Dave Mitton

Chris Beatrice

Julie Airoldi, Chris Beatrice,

Hcidi Mann, Scot Forbes,

Andrea Muzeroll, Chin-Mei Yu

Jay Rinaldi, Jeremy Bell

Michael Stanron, Lezli Whitehouse
Todd Capute, Jennifer Hawthorne
Philip Conrad, Ken Ford, Chris Foster,
Mike Lescault, Joe McGuire,
Edward Pugsley, Steven Serafino

Nos remerciements a Eric Quellette
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INSTALLATION DE CASINO DE LUXE

|

=N

Vortre ordinateur doit étre allumé et vous devez afficher la fenétre du
Gestionnaire de Programmes de Windows.

. Placez le CD du jeu CASINO DE LUXE dans vortre lecteur de CD-ROM.
. Dans le menu Fichier, cliquez sur Exécuter.
. Une fenétre de dialogue apparait, Tapez la lettre correspondant a votre

lecteur de CD-ROM, suivie de deux points (:), puis \SETUP.EXE et
pressez la touche <Entrée> de votre clavier. Par exemple, si votre lecteur
de CD-ROM correspond i la lettre D, vous devez taper D:\SETUP:EXE
puis appuyer sur <Entrée>.

. Suivez les instructions données a I’écran. Au cours de I'installation, deux

options vous seront proposées : installer la totalité du jeu sur votre disque
dur ou juste une partie, 'accés au reste des données se faisant directement
sur le CD pendant le jeu. Si vous installez la totalité du jeu (« copie sur le
disque dur »), vous devez disposer d’un espace libre de 30 Mo sur le
disque dur. Si vous n'installez qu'une partie du jeu (« Résident sur CD »)
les données copiées sur le disque occuperont un espace de 4 Mo. S7 vous
optez pour une installation partielle, n'oubliez pas d'introduire votre CD
dans le lecteur lorsque vous jouez ou pour visualiser les suppléments de straté-
gie. Uinstallation compléte permet un jeu plus rapide.

. La procédure d’installation crée un groupe de programmes appelé

Impressions, qui contient I'icone programme du jeu, ainsi que les icénes
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des sections stratégie de chaque jeu du coffret. pour jouer 2 CASINO DE
LUXE, double-cliquez sur I'icéne du jeu principal. Pour accéder aux sec-
tions trucs et astuces relatives a la stratégie, double-cliquez sur I'icéne du
jeu dont vous souhaitez visualiser la section.

Lorsque vous entrez dans le jeu, vous pouvez voir une séquence d’introduc-
tion. Cliquez avec votre souris pour interrompre ces écrans. Lordinateur
vous demande si vous voulez commencer un nouveau jeu ou charger un jeu
préalablement sauvegardé. Si vous jouez pour la premiére fois, sélectionnez
Nouveau. Si vous désirez continuer un jeu préalablement sauvegardé, cliquez
sur Ouvrir, et choisissez votre jeu dans la boite de dialogue qui apparait.
Vous vous trouvez dans le hall du CASINO DE LUXE. Pour commencer,
cliquez sur les portes de I'ascenseur (ou sélectionnez Aller i I'ascenseur sur la
barre de menu), puis sélectionnez le bouton correspondant au jeu auquel
vous souhaitez jouer (ou sélectionnez Choix du jeu sur la barre de menu).
Pour sortir du CASINO DE LUXE depuis le hall, cliquez sur les portes
vitrées (ou sélectionnez Quitter Casino De Luxe dans le menu Fichier).
Pour obrtenir des instructions générales sur le jeu, cliquez sur Comment
jouer dans le menu Aide du hall. Consultez le menu Aide de chaque jeu
pour obtenir des informations spécifiques. Pour sauvegarder un jeu, sélec-
tionnez Sauver jeu dans le menu Fichier et tapez le nom 4 donner 2 votre jeu
dans la boite qui apparait. N'oubliez pas I'extension de type « .SAV » (par
exemple MONJEU.SAV).



* SIERRA SUR COMPUSERVE

Sur CompuServe, Sierra offre dans son forum une assistance technique et
des fichiers de correction ainsi que des démos, des indices et des articles
concernant les jeux. Si vous étes membre de CompuServe et désirez accéder

a ce forum, entrez GO SIERRA.

AVERTISSEMENT SUR L’EPILEPSIE

A lire avant toure utilisation d'un jeu vidéo

Certaines personnes sont susceptibles de faire des crises d'épilepsic ou d'avoir des pertes de conscience i la vue
de certains types de lumitre clignotantes ou d'éléments fréquents dans notre environnement quotidien. Ces
personnes s'exposent A des crises lorsqu'elles regardent cerraines images télévisées ou lorsqu'elles jouent i cer-
tains jeux vidéo. Ces phénoménes peuvent apparaicre alors méme que le sujet n'a pas d'antécédent médical ou
n'a jamais été confronté i une crise d'épilepsic.

Si vous-méme ou un membre de vorre famille avez déja présenté des sympromes liés a I'épilepsic (crise ou perte
de conscience) en présence de stimulations lumineuses, veuillez consulter votre médecin avant toute utilisation.

Nous conseillons aux parents d'étre attentifs i leurs enfants lorsqui'ils jouent avec des jeux vidéo. Si vous-méme
ou votre enfant présentez un des sympedmes suivants : vertige, trouble de a vision, contraction des yeux ou des
muscles, perte de conscience, trouble de lorientation, mouvement involontaire ou convulsion, veuillez immé-
diatement cesser de jouer et consulter un médecin.

PRECAUTIONS A PRENDRE DANS TOUS LES CAS POUR LUTILISATION D'UN JEU VIDEO
Ne vous tenez pas trop pres de I'écran. Jouez i bonne distance de I'écran de célévision et aussi loin que le per-
met le cordon de raccordement.

Utilisez de préférence les jeux vidéo sur un écran de perite taille.

Evitez de jouer si vous éres fatigué ou si vous manquez de sommeil,

Assurez-vous que vous joucz dans une pice bien éclairée.

En cours d'utilisation, faites des pauses de dix & quinze minutes toutes les heures.
(Arrété paru au J.0. publié par le Ministére public, essentiellement destiné aux jewx vidéo)

- 10 -



SERVICE CONSOMMATEUR

REPONSES A TOUTES VOS QUESTIONS

7JOURS/ 7 -24H/ 24
INDICES/ASTUCES CONSEILS TECHNIQUES
Serveur vocal interactif Service consommateur
(16)(1) 36 68 46 50* TéL : (16) (1) 4601 46 50 Fax:(16)(1)46317172
24h sur 24 7 jours sur 7 de 9h a 21h

#2.23 FF la minute; tarifl en vigueur au 21 septembre 1995,
{ France métropolitaine seulement)

Pour toute information complémentaire,
n’hésitez pas a écrire a :

COKTEL VISION
S.AV
Immeuble le Galilée

Parc Tertiaire de Meudon, 5 rue Jeanne Braconnier,
92366 Meudon La Forét Cedex
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Chacune des sociétés du groupe SIERRA est dénommée «SIERRA» dans les
paragraphes suivants.

SIERRA n’assume aucune responsabilité directe ou indirecte, implicite ou explicite,
concernant ce produit et n"assure d'autres garanties que celles imposées par la loi.
SIERRA décline toute responsabilité sur 'utilisation de ce produit i des fins
particulieres et sur la commercialisation de ce produit. Certains états ou pays
n’autorisent pas la limitation ou I'exclusion de certaines garanties implicites et cette
limitation peut ne pas s’appliquer a votre cas.

SIERRA ne pourra en aucun cas étre tenu pour responsable des dommages de
quelque nature que ce soit, direct ou indirect liés a I’ utilisation de ce produit, méme
si SIERRA est avisé ou averti des possibilités de tels dommages. SIERRA ne pourra
donc pas étre tenu pour responsable des pertes de profits ou de revenus, ou de
dommages ou cofits résultant d"une perte de temps, de données ou de I’ utilisation de
ce logiciel, ou pour tout autre motif. En aucun cas la responsabilité de SIERRA ne
pourra étre engagée au-dela du prix d'achat de ce produit. Certains états ou pays
n'autorisent pas la limitation ou I'exclusion de certaines garanties implicites et cette
limitation peut ne pas s appliquer & votre cas.

Vous avez le droit d’utiliser ce produil pour votre usage personnel, mais vous ne
pouvez pas vendre ou tranférer des reproductions du manuel, de la documentation ou
du code de ce produit sous quelque forme que ce soit, ou louer ce produit a un tiers.
Vous ne pouvez utiliser qu'un seul exemplaire de ce produit sur un seul terminal
connecté & un seul ordinateur. Vous ne pouvez pas utiliser ce produit en réseau ou
I"installer sur plus d’un ordinateur ou d'un terminal d'ordinateur.
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WARRANTY CARD TO BE RETURNED (Please complete in capitals)

Here are 3 great reasons why you should return your coupon today:

* Any faulty disk is guaranteed for 90 days and will be exchanged within that period of time.

* Qur Customer/Technical support - tel: (01734) 303 171 - will answer all your questions form Monday to
Friday (9 am to 5 pm) and will solve your technical problems.

« We will regularly notify you of new releases, special offers, and competitions.

SURNAME" |1 1 4 L 1 1 ¢ 4 k1 Y _J K _] I [N [ I -
FIRSTNAME L L | | | L1 1 1 | ICUTSOMERN*| | | | L 1 |
DATEOFBIRTH L1 | | | I ADDRESS L 1L v | ¢ [ [ | | | |
A N (IO D U (Y |0 IO S U AN AN <O S N e I (S ) N (N | =
™WN L1491 |- ¢ ¢+ .4 J; - A:;° 3 POSTCODE| | | | | |
countRyl 1 1t 1 1 ¢ 1 ¢ i - 1TEEL ) &0 a9 1
*Please indicate customer number il you already have one

COMPUTER OPERATING SYSTEM PERIPHERALS
PCQ MACQ OTHER O MS/DOS 1 WINDOWS L CDROMQ PRINTER O

0s20 OTHER A MODEM O SOUNDCARD Q

TITLEOFPRODUCTPURCHASED L L1 1 1 1 I 1 1 1 I __L_ 1 1 |
DATEOFPURCHASE: L 1 | 1 | J Format: FLOPPY. 4 CDROM Q1
* Name of the store where you purchased the game: Country:

* How did you hear about this product?

1 Presse W Catalogue Q TV/Radio [ Friends (A Stores 0 Other
* Which magazines do you read regulary ? (in order of preference)
COMPUTER-GAMING MAGAZINES OTHER MAGAZINES
I 2 __ | 2

3 R 3 4




Sierra On-Line Ltd
4 Brewery Court,
Theale, Reading,
Berkshire RG7 5AJ
United Kingdom
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BON DE GARANTIE A NOUS RETOURNER (Remplir en majuscules)

3 bonnes raisons de nous retourner dés aujourd'hui ce coupon-réponse :

* La garantie contre défauts éventuels : durant 90 jours tout disque défectueux vous sera échangé.

* Un technicien est a votre disposition 7jours/7 au (16) 1 46 01 46 50 pour répondre de %h i 21h priori-
tairement i toutes vos questions sur |“utilisation de votre jeu et vous donner des conseils techniques.
* Une information réguliére sur nos nouveautés, nos promotions, nos concours, elc.

NOM D VA VI N O O O O O N B N [ 'O (I |

MeRNoNe Lt 1 L 1 ) 1 & 1 INprermNtel_ 41 L 1 1 )

DATEDENAISSANCE || | | | | | ADRESSE L || | | | | |

S LSS N R Y | A | S (N [N VO A/ (N A S . S | -

VILLEL | | ¢ | | 1 1 1 1 1 | | CODEPOSTALL | | | I

PAYS LIt & & E - L 1§ PRl bl bt L]

*Si vous avez déji un numéro de client, veuillez I'inscrire

ORDINATEUR SYSTEME D’EXPLOITATION PERIPHERIQUES

PCQ MACO AUTRE MS/DOS O WINDOWS O CDROMQ IMPRIMANTE O
0sr2u AUTRE QO MODEM QO CARTE SONQ

TITREDUPRODUITACHETE: | | 1 | & 1 | & 1 | | | 1 1|

DATE D’ACHAT : |

|

|

|

|

= Si acheté en magasin, nom du magasin :

* Comment avez-vous connu le produit ?
Q Presse O Catalogue 2 V/Radio Q Amis [J Magasins O Autre
* Quels magazines lisez-vous réguliérement ? (par ordre de préférences)

l
3

MAGAZINES MICRO AUTRES MAGAZINES
2 — . ] 2
4 3 +

Support : DISQUETTE 2

Ville:

CDROM QO




Ne pas

Affranchir
CORRESPONDANCE-REPONSE
VALABLE DU :
09/01/1995 au 08/01/1998
Coktel Vision

Autorisation N° 809

A utiliser seulement en 92366 Meudon-la-Forét Cedex

France métropolitaine et
dans les départements France

d'Qutre-Mer




Developed by Impressions Software, Inc., a wholly owned subsidiary of
Sierra On-Line, Inc. 1995 Sierra On-Line, Inc. All rights reserved. ®
and/or ™ designate trademarks of, or licensed to Sierra On-Line, Inc.
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